
Informatica® Data Transformation
10.2.1
Informatica® Data Transformation Studio
9.6.1

Migration Considerations for 
Studio 9.6.1 to Data 
Transformation 10.2.1 
Migration 



Informatica Data Transformation Data Transformation Studio Migration Considerations for Studio 9.6.1 to Data Transformation 10.2.1 Migration
10.2.19.6.1
August 2018

© Copyright Informatica LLC 2018, 2019

Publication Date: 2019-08-21



Table of Contents

Abstract. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  iv

Chapter 1: Migration Considerations when Migrating from Studio to 
Informatica Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

Introduction to Data Processor Transformations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

Product Availability Matrixes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Supported Library Versions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Migration Process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

Before You Install. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Perform Backup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Determine the Services and Clients to Install. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Get Installers and Supported Libraries. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Perform the Pre-Installation Steps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Perform the Installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

After You Install. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Perform Post-Installation Steps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Install Libraries. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Copy Files and Import Services. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Getting Started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Migration Limitations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Table of Contents        3



Abstract
This document provides information to consider when you migrate from Studio Data Transformation to the 
Informatica platform.
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Migration Considerations when 
Migrating from Studio to 
Informatica Developer

This chapter includes the following topics:

• Overview, 5

• Introduction to Data Processor Transformations, 6

• Product Availability Matrixes, 7

• Supported Library Versions, 7

• Migration Process, 8

• Before You Install, 9

• Perform the Installation, 11

• After You Install, 11

• Getting Started, 13

• Migration Limitations, 13

Overview
The Informatica platform consists of an Informatica server component and one or more client components, 
such as Informatica Developer. Informatica provides separate installers to install the Informatica server and 
clients. Before you start the installation process, determine what servers and clients you want to install. 
When you migrate from a standalone Data Transformation Studio installation to the Informatica platform, you 
will install the Informatica services and the Developer tool.

The Developer tool includes the Data Processor transformation as an evolution of the standalone Data 
Transformation Studio. With the Developer tool, you can create, edit, and test Data Processor 
transformations in a development environment. To run the transformations, export the transformations as 
Data Transformation services. You use the Data Transformation engine to run services in the production 
environment.

When you migrate from Studio to the Informatica platform, you first install the Informatica server. As part of 
the server installation, you create the application services including a Model Repository Service and Data 
Integration Service. You use the Model repository to store the transformations, mappings, and other objects. 
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Data Integration Service performs data integration jobs tool. To create and edit transformations and 
mappings, you must install the Developer tool.

To migrate from a Studio standalone installation, install an Informatica server and the Developer tool in the 
development environment. Install a Data Transformation engine in the production environment.

You use the Developer tool to create, edit, and test Data Processor transformations in the development 
environment. Using the Developer tool, you export Data Transformation services. You copy the Data 
Transformation services to the production environment and run the services using the Data Transformation 
engine.

Introduction to Data Processor Transformations
The Data Processor transformation processes complex files, such as messaging formats, HTML pages and 
PDF documents. Data Transformation also transforms formats such as ACORD, HIPAA, HL7, EDI-X12, 
EDIFACT, AFP, and SWIFT.

You can define a Data Processor transformation to transform complex files in a mapping. When you run a 
mapping with the Data Processor transformation, the Data Integration Service calls the Data Transformation 
engine to process the data. The Data Integration Service is an application service that performs data 
integration jobs that you configure in the Developer tool.

Data Transformation has the following elements:

Data Processor transformation

A transformation that processes complex files in a mapping. Define a Data Transformation Script, XMap, 
Library, or Validation Rules object in the Developer tool to process the data. You can include the 
transformation in an SQL data service mapping, web service, or mapping profile.

Data Transformation service

A set of Data Transformation objects that you can export from Data Processor transformation and run 
standalone. You export a service to a Data Transformation repository and run the service from there.

Data Transformation repository

A directory that stores executable services that you export from a Data Processor transformation. The 
repository directory name is ServiceDB.

Data Transformation Engine

A processor that runs objects in the Data Processor transformation or services that you create in 
Developer tool.

In Data Transformation Studio, you created projects and deployed them as Data Transformation services. 
Similarly, in the Developer tool, you create Data Processor transformations and can export them as Data 
Transformation services.

In Data Transformation Studio, as part of a project, you created Scripts with the IntelliScript editor. You 
deployed projects as Data Transformation services that the Data Transformation engine ran, or you imported 
the services into PowerCenter to incorporate into mappings.

In the Developer tool, similarly, you create Data Processor transformation Scripts with the Data Processor 
transformation wizard, and define them in the Intelliscript editor and other editors. You can export Data 
Processor transformations as Data Transformation services to run with the Data Transformation engine, or in 
PowerCenter. For more information about Data Processor transformations, refer to the Informatica 10.2 Data 
Transformation User Guide.
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To work with Libraries the Developer tool, you can use a dedicated Library Editor to view and to edit the 
Library specifications for supported Libraries. For more information, see the “Libraries” chapter in the 
Informatica 10.2 Data Transformation User Guide.

Product Availability Matrixes
Product Availability Matrixes (PAMs) indicate the versions of operating systems, databases, and other types 
of data sources and targets the product release supports. If you are an Informatica Network member, you can 
access PAMs at the following link: 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Supported Library Versions
After you install the Developer tool, you must install the Libraries. The following table describes which Library 
versions are supported:

Library name Library Version Supported Data Transformation version

ACORD AL3 Library 10.0.0 9.6.1 and above

ACORD-MDM Mappers Library 10.0.0 9.6.1 and above

ASN1 Library (+)

BAI Library 10.0.0 9.6.1 and above

Bloomberg Library 10.0.0 9.6.1 and above

COBOL Processing Library (+)

CREST Message Structure 10.0.0 9.6.1 and above

DTCC-NSCC Library 10.2 9.6.1 and above

EDI Accelerator 10.1.0.1 9.6.1 and above

EDIFACT Library 10.1.1 9.6.1 and above

EDI-X12 Library 10.1.1 9.6.1 and above

FIX Library 10.0.0 9.6.1 and above

FpML Library 10.0.0 9.6.1 and above

GDSN & 1Sync 10.1.0.1 9.6.1 and above

GSDN Accelerator 10.2.1 9.6.1 HF4 and above
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Library name Library Version Supported Data Transformation version

HIPAA Accelerator 10.1.0.1 9.6.1 and above

HIPAA Library 10.1.1.0 9.6.1 and above

HIX Library 10.1.0.1 9.6.1 and above

(+) All supported Data Transformation versions where this library import is available.

Note: You must install Library versions 10 and up to work with Libraries in the Data Processor transformation 
Library Editor.

Migration Process
When you migrate from Studio and install Informatica services and clients, the process consists of multiple 
phases. The migration consists of the following phases:

1. Back up Studio projects and custom files.

2. Complete the pre-installation tasks for the Informatica domain to ensure that you can successfully run 
the installer.

3. Create the domain. The Informatica domain is a collection of nodes and services that define the 
Informatica environment. To create the domain, run the Informatica server installer. The installer wizard 
installs the server files and configures the domain.

4. Create the application services, such as the Model Repository Service and Data Integration Service. After 
you create the domain, log in to the Administrator tool and create other application services.

5. Install the Informatica clients. Use the client installer to install the Developer tool. The Developer tool 
should have the same Informatica version as the domain.

6. Perform the post-installation tasks.

7. Install the Libraries.

8. Restore the custom files.

9. Import Data Transformation services into the Model repository.

Note: The process might differ depending on the migration path.

For more information about planning and configuring the installation, refer to the Informatica 10.2 Installation 
and Configuration Guide.

For more information about configuring the Application Services, refer to the Informatica 10.2 Application 
Service Guide and the Informatica 10.2 Administrator Guide.
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Before You Install
Before you perform the Informatica platform installation, back up necessary files and directories, determine 
what servers and clients to install, prepare the system architecture, and obtain all necessary Informatica 
installer packages. Plan and prepare to install the domain and Application Services.

For more information about planning and configuring the domain and Application Services, refer to the 
Informatica 10.2 Installation and Configuration Guide.

Perform Backup
Before you perform installation, back up your Informatica product licenses, the Studio repository, all projects, 
and custom components or files.

Perform the following actions:

1. Locate the Studio Repository

2. Deploy any Undeployed Services

3. Back Up the Data Transformation Files

Step 1. Locate the Studio Repository
Data Transformation services are stored in the Data Transformation repository directory. Ensure that you 
know where the repository is so that you can back it up before the installation procedure.

The following path shows the default repository location in Windows:

<Informatica installation directory>\Informatica \DataTransformation\ServiceDB

This repository location is stored in the CMConfig.xml configuration file which can be examined with a text 
editor.

Step 2. Deploy any Undeployed Services
You can deploy a project as a Data Transformation service on the development host machine where Data 
Transformation Studio is installed. You can later import the service into the Developer tool.

To do this, you must have write privileges for the Data Transformation repository and for the log folder. For 
more information about the required permissions, see the Data Transformation Administrator Guide. In case 
of doubt, contact your system administrator.

To deploy the service, perform the following steps:

1. In Data Transformation Studio, open and select the project.

2. Click Project > Deploy.

3. In the Deploy Service window, set the following options:
Service Name

The name of the service. By default, this is the project name.

To ensure compatibility with the Model repository, the name must contain only English letters (A- Z, 
a-z), numerals (0-9), spaces, and underscores.

Data Transformation creates a directory with the service name in the repository location.

Label

A version identifier. The default value is a time stamp indicating when the service was deployed.
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Startup Component

The component that starts the processing in the Data Transformation service.

Author

The person who developed the project.

Description

A description of the service.

4. Click the Deploy button.

5. Studio displays a message that the service was successfully deployed. The service appears in the 
repository view.

Step 3. Back Up the Data Transformation Files
Before you install the Developer tool, you must back up the Studio Data Transformation files. The ServiceDB 
directory contains CMW files for Data Transformation services.

Back up the following files or directories:

License file.

The license file is located at the following path: <Informatica installation directory>
\DataTransformation\CDELicense.cfg

Custom TGP files.

The files are located at the following path: <Informatica installation directory>
\DataTransformation\autoInclude\user\

Custom JAR and DLL files.

The files are located at the following path: <Informatica installation directory>
\DataTransformation\externLibse\user\

Repository

The files are located at the following path: <Informatica installation directory>
\DataTransformation\ServiceDB\

Ensure that you also back up any deployed services that are not in the ServiceDB directory.

Determine the Services and Clients to Install
Determine what services and clients that you want to install. To migrate from Studio, you will install 
Informatica services and the Data Transformation engine. When you install the Informatica services, you 
create a domain, a Model Repository Service and a Data Integration Service. You will also install the 
Developer tool, a client.

For more information about installation planning and a checklist, refer to the Informatica 10.2 Installation and 
Configuration Guide.
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Get Installers and Supported Libraries
Informatica provides separate installers for the Informatica server and the Developer tool. Before you 
perform installation, download the installers.

After you perform the installation, you must install Libraries onto the machine that hosts the Developer tool. 
Ensure that you install a supported version of the Libraries. To determine if a version is supported, see 
“Supported Library Versions” on page 7.

To check if the messages you want to process are supported by the relevant Library, see the “Product 
Availability Matrixes” on page 7. If your current Library version is not supported, ensure that you obtain a 
supported version.

Perform the Pre-Installation Steps
Before you install, ensure that you perform all relevant pre-installation steps. For more information about pre-
installation steps, refer to the Informatica 10.2 Installation and Configuration Guide.

Perform the Installation
To perform the Informatica platform installation, follow the steps in the installers step by step.

For more information, refer to the Informatica 10.2 Installation and Configuration Guide.

Use the server installer to install the Informatica server and create the services, or to install the Data 
Transformation engine. Use the client installer to install the Developer tool.

To migrate from a Studio standalone installation, use the server installer to install the Informatica server and 
create the Data Integration Service and Model Repository Service in the development environment. Next, use 
the client installer to install a Developer tool in the development environment. Lastly, use the server installer 
to install the Data Transformation engine in the production environment.

After You Install
After you perform the Informatica platform installation, perform the post-installation steps to configure the 
Informatica platform. Next, install the Libraries onto the machine that hosts the Developer tool. After that, 
import the Data Transformation services into the Model repository. Copy the custom files to the machine that 
hosts the Developer tool and to the machine that hosts the Data Transformation engine.

Perform Post-Installation Steps
After you perform installation, ensure that you perform all relevant post-installation steps.

For more information, refer to the Informatica 10.2 Installation and Configuration Guide.

Install Libraries
After you install the Developer tool, install the Libraries on the same machine.

For the installation procedure, refer to Informatica 10.2 Libraries User Guide.

Perform the Installation       11



Copy Files and Import Services
Perform the following procedures after you install the Developer tool:

1. Restore the backed-up files.

2. Import services into the Model repository.

Step 1. Restore the Data Transformation Service Files
After you install the Developer tool, you must restore the Studio Data transformation files. Restore the files to 
both the development and production environment. Copy the backed-up files to the following locations:

Custom TGP files.

Copy to the following path: <Informatica installation directory>\DataTransformation
\autoInclude\user\

Custom JAR and DLL files.

Copy to the following path: <Informatica installation directory>\DataTransformation
\externLibse\user\

Repository

Copy to the following path: <Informatica installation directory>\DataTransformation\ServiceDB
\

Ensure that you copy custom files to both the development and the production environments. That is, copy 
the custom files to the machine with the Developer tool and to the machine with the Data Transformation 
engine.

Ensure that you also copy any deployed services that are not in the ServiceDB directory.

Step 2. Import Data Transformation Services
You can import Data Transformation services from the directory where you saved the services. You can 
import a Data Transformation service to the Model repository to create a Data Processor transformation. The 
Developer tool imports the transformation, schemas and example data with the CMW file of the Data 
Transformation service. If you have many services, you can import a directory of services instead.

Importing a Directory of Data Transformation Services

To import a directory of services into the Developer tool repository, perform the following steps:

1. In the Developer tool, click File > Import. The Import dialog box appears.

2. Select Informatica Import Data Transformation Services (Folder) and click Next.
The Import Data Transformation Services page appears.

3. Browse to select the directory that you want to import.

4. Browse to a location in the Model repository where you want to save the directory, and then click Finish.

The Developer tool imports the transformations, schemas and example data.

Importing a Data Transformation Service

To import a single service into the Developer tool repository, perform the following steps:

1. In the Developer tool, click File > Import. The Import dialog box appears.

2. Select Informatica Import Data Transformation Service (Single) and click Next.
The Import Data Transformation Service page appears.
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3. Browse to the service CMW file that you want to import. The Developer tool names the transformation 
according to the service file name. You can change the name.

4. Browse to a location in the Model repository where you want to save the transformation, and then click 
Finish.

The Developer tool imports the transformation, schemas, and example data with the CMW file.

Getting Started
In the Developer tool, you create Data Processor transformation Scripts with the Data Processor 
transformation wizard, and define them in the Intelliscript editor and other editors.

To work with Libraries the Developer tool, you can use a dedicated Library Editor to view and to edit the 
Library specifications for supported Libraries.

You can learn more about the Developer tool, the Data Processor transformation, and the editors, with the 
following resources:

Working with the Developer tool.

To learn more about working with the Developer tool, see the Informatica 10.2 Developer Tool Guide.

Working with the Data Processor transformation

To learn more about creating Data Processor transformations and about Data Processor transformation 
functionality, see the Informatica 10.2 Data Transformation User Guide.

To learn more about working with the Data Processor transformation capabilities, use the tutorials 
provided in the Informatica 10.2 Data Processor Transformation Getting Started Guide.

Working with libraries.

To work with Libraries in the Developer tool, you can use a dedicated Library Editor to view and edit 
Library specifications. For more information, see the “Libraries” chapter in the Informatica 10.2 Data 
Transformation User Guide.

Migration Limitations
The following limitations apply when migrating from Studio to Informatica Developer, and from Data 
Transformation projects to Data Processor transformations in mappings.

Limitations and Solutions

Perform the following activities to address migration limitations:

Limitation Workaround

Cannot import projects directly into the Developer 
tool.

Export projects as Data Transformation services from Studio 
and import services into the Developer tool.

The Developer tool does not contain a workspace 
with projects and related objects.

Use the Model repository to store transformations, schema 
objects, and data objects instead.
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Limitation Workaround

The Developer tool does not contain a workspace 
with access to logs.

In the Developer tool, view log events from the Events view.

Cannot develop BIRT reports in the Developer tool. Install an external Eclipse environment and develop BIRT reports 
in the external Eclipse environment. You can create or import a 
related Data Transformation service in the Developer tool, and 
then run the service with the Data Transformation engine.

When you import a service with schemas from 
Studio, the schemas are combined into a single 
schema, not imported as separate schemas. The 
resulting schema might not be valid because of 
namespace and alias conflicts.

Create schema objects directly in the Developer tool and 
integrate them into Data Processor transformations.

A Data Processor transformation cannot use a 
variable to designate a relational input port.

Not currently supported in Data Transformation. Replace 
variables in relational input ports.

When you import a project with dependencies, If 
dependent projects are not in the ServiceDB 
directory, the import might fail.

Ensure that all dependencies are available in the ServiceDB 
directory. For example, ensure that SWIFT lookup sample files 
are available in the ServiceDB directory.

Cannot redefine a variable identifier and 
automatically update all instances of the 
identifier.

Not currently supported in Data Transformation. You must 
manually update all instances of a variable identifier.

Cannot run a transformation on two or more files 
at once.

You can use a Joiner transformation to obtain data from two 
heterogenous sources, and then pass the data to a Data 
Processor transformation in the same Informatica mapping. The 
Joiner transformation can join source data from two related 
heterogeneous sources from different locations or from 
different file systems.

A Data Processor transformation with a Streamer 
as the startup component might fail due to a 
service parameter.

Apply EBF-11004 to resolve this issue.

Cannot edit a Script in script mode. In the Object view, click the Script, and select Open with 
External Editor. Edit the Script, save it, and then close it. Select 
Update Data Processor. The Developer tool updates the Script.

Cannot edit a schema file in an XSD editor. In the Overview view, select the schema object, and click Open 
with > Other > System Editor. Edit the schema, save it, and then 
close it. Select Update Schema Object. The Developer tool 
updates the schema.

For a relational to hierarchical Data Processor 
transformation, the Developer tool cannot auto-
generate a schema to reflect the relational input.

Not currently supported in Data Transformation. You must 
create a schema that you can use with the transformation.

Click an error in the Validation Log view, and then 
view the Script location associated with the error 
in the IntelliScript editor.

Supported in Data Transformation 10.2 HF1.

Cannot create a serializer by inverting a parser. Not currently supported in Data Transformation.
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